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1 Introduction 

1.1 About this Manual 

It is assumed that you already have a basic understanding of technical and software terms. No special 
skills are required to read this manual. If you are using the device for the first time, please read the 

Important Safety Advice before installing the hardware and software, where you will find 
important information about the installation and first steps. The device and the software are part  
of an ongoing developmental process. Please understand that the provided documentation is not  
always up to date. The latest information can be found in the help. Check also the MCS web site 
(www.multichannelsystems.com) for downloading up-to-date manuals and help files. 
 
 

http://www.multichannelsystems.com/
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1.2 Welcome to the USB-MEA32-STIM4 

  
 

The USB-MEA32-STIM4 is a compact and portable stand-alone solution for extracellular recordings  
with integrated amplifiers, data acquisition, and a four channel current stimulus generator. Perfusion 
heating and the possibility to apply suction through perforated MEAs are also included. It is a highly 
compact system: The system acquires data from up to 32 electrode channels. The digitized electrode  
data is transmitted to the connected computer via universal serial bus (High Speed USB 2.0). Thus,  
it is possible to use any computer as a data acquisition computer, also a laptop. Up to four systems can  
be controlled independently from a single computer. Data is recorded, graphed, analyzed, and reviewed 

with the powerful and easy-to-use MC_Rack program from Multi Channel Systems MCS GmbH.  

You can export the data in standard formats to other programs with the software MC_DataTool.  

 

MC_Stimulus II program controls the stimulation on up to four of the twelve stimulation electrodes at 
a time. As a more convenient alternative for LTP (long term potentiation) experiments, the new software 

package LTP-Director and LTP-Analyzer is available. This software is able to control both, recording 
and stimulation from one program, and also has many useful features for LTP recordings. 
 

The USB-MEA32-STIM4 is designed primarily to do recordings from acute slices. Four different layouts 
of the perforated MEAs are available, each with 32 recording and twelve separate stimulation electrodes. 

The USB-MEA32-STIM4 is not compatible with the squarish standard 60 channel MEAs. The integrated 
filter amplifier supports 32 electrode channels. The amplifier gain of 1000 is fixed. The bandwidth of  
0.5 Hz to 3 kHz is suitable for a broad range of applications, such as spikes and field potential recordings. 
The device can be used in combination with a binocular or an inverted microscope. Acute slices can be 
kept in position and in good contact with the electrodes by applying suction through the perforated MEA 
from below. 
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2 Important Safety Advice 

2.1 Operator's Obligations 

The operator is obliged to allow only persons to work on the device, who 

 are familiar with the safety at work and accident prevention regulations and have been instructed 
how to use the device; 

 are professionally qualified or have specialist knowledge and training and have received instruction  
in the use of the device; 

 have read and understood the chapter on safety and the warning instructions in this manual  
and confirmed this with their signature. 

It must be monitored at regular intervals that the operating personnel are working safely. Personnel still 
undergoing training may only work on the device under the supervision of an experienced person. 
 
 

2.2 Guarantee and Liability 

The general conditions of sale and delivery of Multi Channel Systems MCS GmbH always apply. The 
operator will receive these no later than on conclusion of the contract. Multi Channel Systems MCS 
GmbH makes no guarantee as to the accuracy of any and all tests and data generated by the use of  
the device or the software. It is up to the user to use good laboratory practice to establish the validity  
of his / her findings.  
 
Guarantee and liability claims in the event of injury or material damage are excluded when  
they are the result of one of the following. 

 Improper use of the device. 

 Improper installation, commissioning, operation or maintenance of the device. 

 Operating the device when the safety and protective devices are defective and/or inoperable. 

 Non-observance of the instructions in the manual with regard to transport, storage, installation, 
commissioning, operation or maintenance of the device. 

 Unauthorized structural alterations to the device. 

 Unauthorized modifications to the system settings. 

 Inadequate monitoring of device components subject to wear. 

 Improperly executed and unauthorized repairs. 

 Unauthorized opening of the device or its components. 

 Catastrophic events due to the effect of foreign bodies or acts of God. 
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2.3 Important Safety Advice 

 

Warning: Make sure to read the following advice prior to installation or use of the device and 
the software. If you do not fulfill all requirements stated below, this may lead to malfunctions 
or breakage of connected hardware, or even fatal injuries. 

 

Warning: Always obey the rules of local regulations and laws. Only qualified personnel should 
be allowed to perform laboratory work. Work according to good laboratory practice to obtain 
best results and to minimize risks. 

 
The product has been built to the state of the art and in accordance with recognized safety engineering 
rules. The device may only 

 be used for its intended purpose; 

 be used when in a perfect condition. 

 Improper use could lead to serious, even fatal injuries to the user or third parties and damage  
to the device itself or other material damage. 

 

Warning: The device and the software are not intended for medical uses and must not be used 
on humans. MCS assumes no responsibility in any case of contravention. 

Malfunctions which could impair safety should be rectified immediately. 

High Voltage 

Electrical cords must be properly laid and installed. The length and quality of the cords must be  
in accordance with local provisions.  
 
Only qualified technicians may work on the electrical system. It is essential that the accident prevention 
regulations and those of the employers' liability associations are observed. 

 Each time before starting up, make sure that the power supply agrees with the specification 
of the product. 

 Check the power cord for damage each time the site is changed. Damaged power cords should  
be replaced immediately and may never be reused. 

 Check the leads for damage. Damaged leads should be replaced immediately and may never  
be reused. 

 Do not try to insert anything sharp or metallic into the vents or the case. 

 Liquids may cause short circuits or other damage. Always keep the device and the power cords dry. 

Do not handle it with wet hands. 

Requirements for the installation 

Make sure that the device is not exposed to direct sunlight. Do not place anything on top of the device, 
and do not place it on top of another heat producing device, so that the air can circulate freely. 
 

 

Warning: The device must not get in contact with fluids! Spilled liquid can damage or even 
completely destroy the electronics of the amplifier! This is eminently important when using 
a perfusion system. Take care that the flow rates of the inlet and outlet flow match so that 
flooding of the amplifier is efficiently prevented. 
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3 Software Installation 

There are two software options available to run an USB-MEA32-STIM4-System: Controlling the data 

recording and processing with MC_Rack in combination with MC_Stimulus for the stimulation, or 

working with LTP-Director. The LTP-Director controls the data acquisition and the stimulation as well. 
Please read the respective manuals or helps for detailed information. 

 

MC_Rack 

The recording and analysis software MC_Rack can be used to work with the USB-MEA32-STIM4-

System. Channel maps for all pMEA layouts are provided, please see chapter "Data Sheet" in the 

Appendix. MC_Rack can be opened up to four times on one PC to control four connected units 
independently.  

 

MC_Stimulus II 

Selection of stimulation electrodes and programming of the current pulses is done with MC_Stimulus 

II. Programming of the internal stimulator works in the same way as the programming of the regular STG 
stimulators from MCS. 

 

LTP-Director and LTP-Analyzer 

The software package LTP-Director and LTP-Analyzer is designed to run standard LTP / LTD 
experiments in acute hippocampal slices. It is less flexible than MC_Rack, but includes the control of 
recording, stimulation and electrode selection, and an integrated documentation of the experiment  
in one program. Furthermore, it is possible to control an automated perfusion system. The course of  
the experiment can be designed up in front, and then runs automatically.  
 
LTP-Director is for recording and LTP-Analyzer for offline analysis of the data. Results can be normalized 
on baseline values and exported as relative ASCII values to a database. 
 
Please check the system requirements before you install the software. MCS cannot guarantee that the 
software works properly if these requirements are not fulfilled. Please see the appropriate help or manual 
for more information. It is recommended that you check the MCS web site for software updates on  
a regular basis. 
 

The USB-MEA32-STIM4 is a plug and play device. The driver is automatically installed together with  

the software. It is easier to install the software first and then connect the USB-MEA32-STIM4 to the 
data acquisition computer. 
 
Important: Please make sure that you have full control over your computer as an administrator. Otherwise, 
it is possible that the installed hardware does not work properly. 
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3.1 System Requirements 

Operating System: One of the following Windows ® operating systems is required:  
 
Windows 7, VISTA or XP (English and German versions supported) with the NT file system (NTFS).  
Other language versions may lead to software errors.  
 

Hardware (Not required for offline analysis or demo mode): The data acquisition board USB-MEA32-

STIM4. If no USB-MEA32-STIM4 is present, MC_Rack / LTP-Director opens in a simulation mode.  
A computer with low performance may lead to performance limits more often; therefore, MCS 
recommends an up-to-date computer preferably with two separate hard disks.  
 

Please note that there are sometimes hardware incompatibilities of the USB-MEA32-STIM4 and 
computer components, or that an inappropriate computer power supply may lead to artifact signals. 
Please contact your local retailer for more information on recommended computer hardware. 
 

Important: You need to have installed the latest USB-MEA32-STIM4 driver to operate the USB-

MEA32-STIM4, which is automatically installed with MC_Rack / LTP-Director. The installation  

may be invalid if the USB-MEA32-STIM4 does not respond. Please contact Multi Channel Systems  
or your local retailer in this case. 

 
 

3.2 Recommended BIOS Settings 

Recommended operating system settings 
 
The following automatic services of the Windows operating system interfere with the data storage on the 
hard disk and can lead to severe performance limits in MC_Rack. These routines were designed for use on 
office computers, but are not very useful for a data acquisition computer. 

 Turn off Screensaver. 

 Turn off Windows Indexing Service. 

 Turn off Windows System Restore. 

 Manual management of automatic Windows Update. 

 Power Options: Power scheme:  Never turn off monitor, hard disk and system standby.  

 It is also not recommended to run any applications in the background when using MC_Rack.  
Remove all applications from the Autostart folder. 

 Be careful when using a virus scanner. These programs are known to disturb MC_Rack,  
and even data loss may occur. 
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Driver Installation 
 

The USB-MEA32-STIM4 is a plug and play device. The driver is automatically installed together with  

the MC_Rack / LTP-Director program. It is easier to install the software first and then connect the  
USB-MEA32-STIM4 to the data acquisition computer. 

Installing MC_Rack with the USB-MEA32-STIM4 connected to the computer 

The Windows operating system detects a new hardware when the USB-MEA32-STIM4 is connected to  
the computer, if the program has not been installed beforehand. Please make sure the device has power. 
Simply cancel the "Found New Hardware Wizard" and proceed with the installation  
of the MC_Rack program.  

Connecting the USB-MEA32-STIM4 to a computer with installed MC_Rack 

If MC_Rack and / or LTP-Director had already been installed on the computer before the hardware was 
connected, the operating system needs to load the driver once. After this procedure, the USB-MEA32-
STIM4 will be automatically recognized by the operating system. 
 
1. Connect the USB-MEA32-STIM4 to the USB port of the data acquisition computer. 
2. Switch the computer on. 
 
The "Found New Hardware Wizard" is displayed. 
 
3. Choose the option "No", not this time and continue with "Next". 
4. Choose the option "Install" the software automatically (Recommended) and continue with "Next". 
5. The Wizard will automatically find the appropriate USB-MEA32-STIM4 driver. Continue with "Next". 
6. The driver installation is finished.  
 
For installation of MC_Rack or LTP-Director, please refer to the respective manuals. It is not recommended 
to run any applications in the background when using MC_Rack. Remove all applications from the 
Autostart folder. 
 

 

Warning: The operating system settings of the data acquisition computer were pre-configured 
by MCS and should not be changed by the user. Changing these settings can lead to program 
instabilities and data loss. 
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4 USB-MEA32-STIM4-System 

4.1 The USB-MEA32-STIM4-System Components 

4.1.1 Filter Amplifier 

The filter amplifier combines a band pass filter and the signal amplification in one instrument. The 
bandwidth of 0.5 Hz to 3000 Hz is suitable for a broad range of applications, such as spikes and field 

potential recordings. The digital filter of the MC_Rack program can be used to adjust the pass band  
and filter the raw data. Please see the MC_Rack help or manual for more information. For most LTP 
experiments, it is recommended to use a digital 10 Hz high pass filter to avoid low frequency noise. 
Please note that the gain factor of the filter amplifier (1000) is a fixed hardware property that cannot  
be changed by software controls. Please also note that the ratio of the output signal to the input signal, 
that is, the gain, is not a fixed parameter for the complete bandwidth. The gain that was specified for  
the amplifier, for example, 1000 is not fully reached at the borders of the amplifier's pass band. The 
general rule is, that at the lower and upper limit of the frequency band, the gain is approximately 70 %  
of the full gain. Therefore, you should use a bandwidth that is at a safe distance of the signals of interest. 
Outside the pass band, the gain decreases with the frequency and finally approaches zero. 
 
For more information on gain and filters in general, please refer to standard literature or contact  
your local retailer. Raw data from up to 32 electrodes of a microelectrode array MEA is amplified by  
32 channels of filter amplifiers that are built very small and compact using SMD (Surface Mounted 
Devices) technology. The small-sized MEA amplifier combines the interface to the pMEA probe with  
the signal filtering and the amplification of the signal. The compact design reduces line pick up and  

keeps the noise level down. The MEA sensor is placed directly into the small-sized USB-MEA32-STIM4 
amplifier. When the amplifier is closed, the contact pins in the lid of the amplifier are pressed onto the 
MEA contact pads. The very close location of the amplifier to the MEA sensor is very favorable concerning 
a high signal-to-noise ratio. 
 

The amplifier is intended to be used with a binocular or an inverted microscope. The USB-MEA32-

STIM4 amplifier is compatible with most standard microscopes. If necessary, you can use a Faraday  
cage or appropriate materials, for example, aluminum foil for shielding the amplifier. The shielding  
should be connected to the amplifier's ground. 
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4.1.2 Data Acquisition 

Electrode raw data are acquired from the special designed perforated MEA and digitized by the 

analog / digital converter board that is integrated into the main unit. Recorded signals are 
converted in real time into digital data streams at sampling rates of up to 50 kHz per channel. You will 
not miss even fast biological signals. Data is transferred to the computer via High Speed USB 2.0 port. 
 

4.1.3 Stimulus Generator 

The internal stimulator generates current controlled pulses only. The maximum output current is ±256 µA, 
the resolution is 13 bit, and the time resolution is 20 µs. Twelve stimulation electrodes can be connected 
via software control to the four channels of the internal stimulus generator. Selection of the stimulation 

electrodes and programming of the stimulation pulses is done either with MC_Stimulus II or with the 

LTP-Director. Please read the respective manuals / helps for more information. 
 

4.1.4 Perfusion 

Perfusion Cannula PH01 

 
 

A PH01 perfusion cannula is already integrated on top of the USB-MEA32-STIM4-System.  

Connected to a TC01/02 temperature controller, it is possible to keep the temperature of the perfusion 
medium constant at the desired value. There is no heating element below the MEA as with the regular 
MEA amplifiers. 
 
Bath or test solutions can be applied at flow rates from 500 µl to 4.5 ml per minute. The PH01 can be 
connected to any tubing that fits to the perfusion inlet (luer lock) and outlet (1 mm OD stainless steel 
cannula). A titanium wire inserted into the cannula results in a turbulent flow that ensures that the 
temperature of the liquid is constant across the flow stream. For setting up a complete perfusion system, 
a pump and a perfusion port for aspirating the liquid from the culture chamber are required. Standard 
setups for MEA recording use a peristaltic pump or syringe pump, and a standard metal cannula with 
beveled tip for aspiration. 
 
The PH01 is equipped with a standard platinum temperature sensor (PT 100). The fluid temperature is 
controlled by the connected temperature controller TC01/02. To connect the perfusion cannula PH01, 
please read PH01 manual for detailed information. A cable is attached to the PH01 which should be 
connected to the system ground. A short cable with two small crocodile clamps is provided to connect  
the suction cannula and the PH01, and thereby also ground the cannula. 
 

 

Warning: The device must not get in contact with fluids! Spilled liquid can damage or even 
completely destroy the electronics of the amplifier! This is eminently important when using 
a perfusion system. Take care that the flow rates of the inlet and outlet flow match so that 
flooding of the amplifier is efficiently prevented. 
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Temperature Controller TC01/02 
 

The USB-MEA32-STIM4 features a PH01 with a PT100 temperature sensor. If you connect  

a temperature controller TC01/02 to the heating element via D-Sub 9 connector, the heating element 
guarantees constant temperature conditions for the biological sample, placed on the pMEA-32S12-Lx.  
The TC01/02 can be controlled manually or by software TCX-Control. Please see the TCX manual for  
more information. 
 

4.1.5 Suction Port 

A suction port is integrated below the frame for the perforated MEA. It is a small sealed compartment 
that is connected to a tube. The red O-ring for sealing this compartment is made of silicon. It has an inner 
diameter of 7 mm and a thickness of 1 mm (Silicon 70, 7 x 1). By the tube, suction can be applied to the 
MEA from below either manually via syringe, or via controlled vacuum pump CVP. Please see chapter 
"Working with the USB-MEA32-STIM4 Amplifier". 
 
 

4.2 Perforated MEA 

   

pMEA32S12-Lx 

For the USB-MEA32-STIM4-System special perforated MEAs have been designed. They are different  
in size, but identical in function to the regular pMEAs. One layout of the perforated MEAs designed for 

the USB-MEA32-STIM4-System has been optimized for acute hippocampal slices. The flat, round 
electrodes are made of titanium nitride (TiN) with a diameter of 30 µm for the recording electrodes, and 
50 µm for the stimulation electrodes. The stimulation electrodes can not be used for recording, and vice 
versa. The interelectrode distances vary from 150 to 200 µm. MEAs with titanium nitride (TiN) electrodes 
are very stable. Therefore, the pMEA can be reused several times and is perfect for long-time experiments 
(up to several weeks and even months).  
 

The electrode impedance ranges between 30 k and 50 k. Tracks and contact pads are made  
of titanium nitride (TiN), the insulation material is polyimide, respectively. The electrodes are integrated 
into a thin polyimide foil. This thin foil is fixed on a ceramic waver for mechanical stability. In the middle  
of the waver, under the electrode field, there is a hole that makes it possible to access the electrode field 
from below. The area around the electrodes is perforated to apply suction to the slice from below. Please 
read chapter "Working with the USB-MEA32-STIM4 Amplifier". The total area of the holes averages  
0.8 mm, the diameters of the holes varies from 20 to 90 µm. Because of the polyimide foil, perforated 
MEAs are heat stable up to 50 °C only.  
 
Important: Do not autoclave or sterilize pMEAs by heat! This type of MEA is not heat stable and will be 

irreversibly damaged!    

For cleaning, rinse them with distilled water first, then apply 1% Terg-A-Zyme solution (Sigma) for several 
hours. Rinse the pMEA again with distilled water and dry them directly before use. Sterilization with 70 % 
ethanol is possible. 
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pMEA32S12 Layouts 
 
The following pictures show the four different pMEA layouts currently available, each with twelve 
electrodes for stimulation, and 32 electrodes for recording. Please see chapter "Data Sheet" in the 

Appendix for pin layout, and for MC_Rack channel maps of the pMEA layouts 1 to 4.  

The layout pMEA32S12-L1, for example, is specifically designed to fit the hippocampal structure.  
The three rows of recording electrodes cover the CA1 area (Cornu ammonis) of the hippocampus.  
The two rows of stimulation electrodes cross the Schaffer Collaterals. The other layouts L2 to L4  
are for more general use. The ellipse indicates the perforated area. 
 

           
L1                                                                              L2   
  

           
L3                                                                              L4 
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Perfusion 
 

 
 
The pMEA carrier is equipped with a glass ring. The ring is 6 mm high, and has an outer diameter of  

24 mm. The ring can be used as perfusion chamber. The USB-MEA32-STIM2-System provides a PH01 
(perfusion cannula) on top of the device. For perfusion you need a peristaltic pump, and for regulating  

the temperature of the perfusion medium a temperature controller TC01/02, connected to the PH01. 

Suction 

Through the perforation in the pMEA, suction can be applied to the slice from below. The suction  
keeps the slice in place and ensures a good electrode to tissue contact without the need for a weight.  
The images show a hippocampal slice with and without suction being applied from below. 
 

 
No suction 
 

 
Suction applied 
 
Suction can be applied manually with a syringe, or with a controlled vacuum pump, also available from 
MCS. Please see chapter "Working with the USB-MEA32-STIM4 Amplifier". 
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4.3 The USB-MEA32-STIM4 Device 

4.3.1 Front  

 

Unit for pMEA with Suction Port 

The perspex insert in front of the main unit contains the frame for the pMEA on top and the suction 

port below. A tube is connected to the small sealed compartment. By this tube, suction can be applied  
to the MEA from below either manually via syringe, or via controlled vacuum pump CVP. 

Holding Clamps 

To open the unit unlock the holding clamps on the left and on the right. The upper part  
of the unit swings open. 
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Contact Pins of the Amplifier 

When the unit is closed, the contact pins of the amplifier connect to the contact pads of the pMEA. 
The contact pins are arranged in five rows with nine pins each. 

Perfusion Cannula PH01 

The PH01 is used for controlling the perfusion of the perfusion chamber on the pMEA. The connected 
temperature controller TC01/02 keeps the temperature of the perfusion medium constant. 

Ground Connectors 

Two ground connectors are available on the front panel of the USB-MEA32-STIM4 device. A cable is 
attached to the PH01 which should be connected to one of the ground connectors. A short cable with 
two small crocodile clamps is also provided to connect the suction cannula and the PH01, and thereby 
also ground the cannula. 
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4.3.2 Rear Panel 

USB 

The USB connector is used to transfer the amplified and digitized data from all data channels and  
the additional digital channel to any connected data acquisition computer via High Speed USB 2.0  
(type A - mini B) cable. 

Power In 

Connect the power supply unit. This power supply powers the USB-MEA32-STIM4 main unit only. 
The device needs 9 V and 1.3 A  / 11.7 W. 
 

 

Ground 

 
 

If an additional ground connection is needed, you can connect this plug with an external ground using  
a standard common jack (4 mm) for the plug and a crocodile clip. 
 

CONNECTING THE USB-MEA32-STIM4 
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4.3.3 Connecting the USB-MEA32-STIM4 

USB-MEA32-STIM4 is a highly compact system with integrated amplification, data acquisition,  
and analog / digital conversion. Via USB High Speed 2.0 it is possible to transfer a digitally converted  
and amplified data stream of up to 32 electrode channels to any data acquisition computer.  
 

Note: Using a USB hub for connecting the USB-MEA32-STIM4 to the computer is not recommended. 
The system needs a broad bandwidth for the data transmission. Recording might not be possible, 
especially if a second device that sends or receives continuous data streams, for example, a web cam  
or USB speakers, is connected to the same USB port.  

 

1. Provide a power supply in the immediate vicinity of the installation site. 

2. Place all devices on a stable and dry surface, where the air can circulate freely and the devices  

are not exposed to direct sunlight. 

3. Set up the computer. Install the MC_Rack / LTP-Director program from the installation volume  

if it is not already installed. The USB-MEA32-STIM4 is a plug and play device. The driver  
is automatically installed together with the software program. 

4. Set up the USB-MEA32-STIM4 amplifier. 

5. Set up the TC01/02. 

6. Connect the USB output connector to a free USB 2.0 port of the data proceeding computer. It is 
not recommended to use an USB hub. Please be aware that USB ports on the front of a PC are 

often connected to the main board via internal USB-Hub. If possible, use a USB-Port on the back. 

7. Connect the USB-MEA32-STIM4 via power supply unit to a power outlet of the same electrical 
system (connected to the same ground / earth wire) as all other components of the setup, for 

example, the computer or shielding. 

8. If necessary, connect the system to an external ground. 

9. Connect the PH01 perfusion cannula to the TC01/02 temperature controller's output channel  

(D-Sub9 socket) with the provided cable. Do not connect the PH01 cable to the computer! 

10. Start the MC_Rack program and select the USB-MEA32-STIM4 as the data source. Please see 

the MC_Rack help or manual for more details on how to define the data source.  

11. Start MC_Stimulus II program for stimulation. Please read the MC_Stimulus help or manual  

for information. 

12. Optionally: Start LTP-Director program. Please read the LTP-Director help or manual for 
information. 
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4.4 Working with the USB-MEA32-STIM4 Amplifier 

4.4.1 Setting up the Amplifier 

For opening the lid of the amplifier, unlock the holding clamps on the left and on the right side.  
The upper part of the unit swings open to enter the pMEA.  

 
 
Now you can insert a test model probe or a perforated MEA into the frame. Below the place for the 
pMEA is a small sealed compartment that is connected to a tube. By this tube, suction can be applied  
to the MEA from below. Be sure that the red O-Ring is in place. This O-Ring (Silicon 70, 7 x 1 mm) seals 
the suction compartment to the pMEA. 
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Place the Test-MEA32S12-Lx test model probe inside. Replace the upper unit, and close the holding 
clamps carefully.  

 

First Functional Tests 

Each MEA amplifier has been thoroughly tested at the factory site before delivery. However, you may 
want to perform some tests yourself before you begin your experiment to exclude any damage that might 
have occurred during transportation. Some of the tests will also help you to get to know the basic 
functions of the hard- and software, like a short tutorial. It will take only a few minutes time and can save 
time and trouble in the long run. Multi Channel Systems recommends running these tests after the setup 
of your system before you start your real experiments. 

General Performance / Noise Level 

Please use the provided test model probe Test-MEA32S12-Lx to test the noise level of the amplifier 

immediately after installation. It simulates a MEA with a resistor of 220 k and a 1 nF capacitor between 
bath and electrode. Use MC_Rack, LTP-Director or your custom data acquisition program to record from 
the test model probe and to check the amplifier. Please see chapter "Test Model Probe” in the Appendix. 
The following screen shot shows a recording from a USB-MEA32-STIM4-System with a test model probe 
and a sampling rate of 40 kHz. 
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4.4.2 Perfusion 

A PH01 perfusion cannula is already integrated on top of the USB-MEA32-STIM4-System. Connected 

to a TC01/02 temperature controller, it is possible to keep the temperature of the perfusion medium 
constant at the desired value. There is no heating from below as with the regular MEA amplifiers. 
 

 
 
To connect the perfusion cannula PH01, please read PH01 manual for detailed information. 
 
Bath or test solutions can be applied at flow rates from 500 µl to 4.5 ml per minute. The PH01 can  
be connected to any tubing that fits to the perfusion inlet (luer lock) and outlet (1 mm OD stainless  
steel cannula). A titanium wire inserted into the cannula results in a turbulent flow that ensures that the 
temperature of the liquid is constant across the flow stream. For setting up a complete perfusion system, 
a pump and a perfusion port for aspirating the liquid from the culture chamber are required. Standard 
setups for MEA recording use a peristaltic pump or syringe pump, and a standard metal cannula with 
beveled tip for aspiration. The height of the aspiration needle can be adjusted with a setscrew. The 
setscrew is the screw closest to the tip of the needle. Make sure to ground both the PH01 and the 
aspiration needle. 
 
The PH01 is equipped with a standard platinum temperature sensor (PT 100). The fluid temperature  
is controlled by the connected temperature controller TC01/02. Please read PH01 and TCX manual for 
more information. 
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4.4.3 Pressure Control in the Suction Port 

Pressure Control via CVP  

The pressure control unit CVP (controlled vacuum pump) is a vacuum pump with a pressure sensor and  
a waste bottle. A sensor measures the pressure in the compartment attached to the waste bottle, and  
can regulate the suction to maintain a constant negative pressure. With this unit, it is possible to precisely 
control the suction applied to the slice and to keep the negative pressure stable during the whole 
recording period. The accuracy of the pressure control is 0.1 mbar, the maximum negative pressure is  
200 mbar below atmospheric pressure. A negative pressure of 10 to 30 mbar is enough to keep a slice in 
place on the electrodes. Please read CVP manual for setting up the vacuum pump. In case of 50 Hz noise, 
include a metal part in the tubing to the CVP and ground it to one of the systems ground connectors.  
It is also recommended to use a valve between the CVP and the system. 
 

 
 

Pressure Control via Syringe 

Suction can be applied manually with a syringe. 

 
 
Connect a 1 ml syringe to the tube. After mounting the slice, gently suck in about 20 to 50 µl with the 
syringe. It is better not to start with the syringe at position 0 ml, better have 100 to 200 µl of air already 
in. Do not apply more suction, or the slice will be sucked into the holes. Most likely the negative pressure 
will dissipate over time, but usually the adhesion of the slice to the pMEA surface is good enough by then 
to keep it in place anyway.  
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4.4.4 Setting up an Experiment 

Open the lid of the amplifier.  
 
Place the pMEA32S12-Lx chip inside the USB-MEA32-STIM4 amplifier. The pin layout is described  
in chapter "Data Sheet” in the Appendix. 
 
Close the lid. 

Grounding the bath 

The pMEA32-STIM4 is equipped with a big internal reference electrode, which will be automatically 
connected to the systems ground when the amplifier is closed. 

Connecting Perfusion Cannula and Temperature Controller 

For setting up a complete perfusion system, a pump and a perfusion port for aspirating the liquid from 
the culture chamber are required. Standard setups for MEA recording use a peristaltic pump or syringe 
pump. The standard metal cannula with beveled tip for aspiration is fixed on top of the USB-MEA32-
STIM4 device beside the PH01.  

Connecting Pressure Control 

Connect the controlled vacuum pump CVP to the tube of the suction port. Please read CVP manual,  
for setting up the controlled vacuum pump. 
 
Alternatively: Connect a 1 ml syringe to the tube of the suction port.  
For more information, refer to the MEA Application Note: Acute Hippocampal Slices on Perforated MEAs.  

Service and Maintenance 

You should clean the contact pins of the amplifier carefully with a soft tissue and alcohol or isopropanol 
from time to time, especially if you have problems with the noise level. For handling and cleaning of the 
pMEA, please refer to the pMEA data sheet or to "MEA Cleaning Quick Guide" on the MCS web site 
www.multichannelsystems.com. 
 

 

Warning: Spilled liquid can damage or even completely destroy the electronics of the  

USB-MEA32-STIM4 amplifier. Please be careful when setting up your perfusion system 
and when starting the perfusion. Take care that the flow rates of the inlet and outlet flow 
match so that flooding of the amplifier is efficiently prevented. 
 

Please be very careful when handling the amplifier, or cleaning the device! The pins can  
be damaged easily. 

 

http://www.multichannelsystems.com/
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5 Recording and Stimulation 

5.1 MC_Rack: Data Acquisition and Analysis 

Please refer to the MC_Rack manual for more information. 
 

1. Start MC_Rack. 

2. Click "Data Source Setup" on the Edit menu. Select USB-MEA32-STIM4. 

 
 

3. Select 1 "Configuration" in Source Layout. The total number of channels is 32 with an additional 

digital input channel if necessary. 

4. The "Amp" will automatically become USB-MEA32-STIM4. Select your MEA type from the 

"MEA" drop down menu. 

5. Click "OK" to close the Data Source Setup. Usually, this setup has to be done only once. 

6. Add USB-MEA32-STIM4 as a data source to your virtual rack. 

7. On the Edit menu, click "Add Data Display" to add a raw data display to your virtual rack. 

8. Click the "Hardware" tabbed page of the USB-MEA32-STIM4. 
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9. Enter the amplifier gain (fix:1000), and the designated sampling frequency. For field potential 

recordings in slices, a sampling frequency of 10 or 20 kHz is ideal. 

                
 

10. Add a data display to you virtual rack by clicking the data display icon, or by selecting it from  
the "Edit" menu. The data display will open with the layout selected in the Data Source Setup. 
 

 

11. Click the Start button to start the data acquisition. No data is recorded. You see the raw data 

streams of all 32 channels in the specific layout. 

12. You may have to adjust the position and span of the axes until you can clearly see the noise level. 
You should see the baseline with a maximum noise level of +/- 8 µV. Be aware that the USB-
ME32-STIM4 has a wide filter bandwidth (0.5 Hz to 3 kHz). Therefore, it is likely that you will pick 
up low frequency noise. To avoid this, use a virtual 10 Hz High Pass filter (see MC_Rack manual 

for details).  
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Operating more than one USB-MEA32-STIM4-System with multiple instances of 

MC_Rack 
 
Using USB-MEA32-STIM4-Systems, it is possible to operate up to four devices with one instance  
of MC_Rack for each device on a single data acquisition computer. 
 
Click "Advanced Configuration" in Edit menu to select the number of instances of MC_Rack  
that you want to run simultaneously. Please see the following screen shot. 
 

  
 
Start the first instance of MC_Rack. 
 
Click Data Source Setup on the Edit menu. All connected devices should become available in the Data 
Source with different serial numbers. Select the device you want to control with the first instance of 
MC_Rack via serial number. 
 

  
 
Adjust the settings as described above. Start the second instance of MC_Rack. In the "Data Source", 
select a device with a different serial number and repeat the process described above. 
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Once all MC_Rack instances are assigned to the respective devices, you can operate each device 
independently. The serial number of the connected device will be shown in MC_Rack main window. 
 

  
 

Opening an existing Rack File with USB-MEA32-STIM4 and multiple instances  

of MC_Rack 
 
If you build up (and saved) a complicate rack in the first instance of MC_Rack which you want to reuse  
in the second instance of MC_Rack, please do the following: 
 

1. Start the second instance of MC_Rack.  

2. Click "Open" in File menu. The dialog "Open Rack Files" appears. 

3. Select the rack file you want to open. 

4. Before the selected file will open in the second instance of MC_Rack, you have to change the 
data source device specification from the copied file. That is why the dialog "Channel Layout"  
in Data Source Setup will automatically appear again. Please choose the appropriate USB-MEA32-

STIM4 device via serial number, assigned the second instance of MC_Rack. 

  
Now the reused rack file will be opened in the second instance of MC_Rack. The data source  
used for the rack is shown in the header and after the data source icon. 
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Note: Please do not miss one of the described steps when reusing an existing file! Otherwise  
you have to delete the rack and start the instance of MC_Rack again. 
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5.2 MC_Stimulus: Stimulation Control 

The twelve stimulation electrodes can be connected via software control to the four channels of  
the internal stimulus generator. The internal stimulator generates current controlled pulses only.  
Selection of the stimulation electrodes and programming of the stimulation pulses is done either  

with MC_Stimulus II or with the LTP-Director. Please read the respective manuals / helps for  
more information. 
 

5.2.1 Device Setup 

Start MC_Stimulus II. 
 
In Settings menu of the main menu toolbar, select “STG Device Setup”. The “STG Settings” dialog 
appears. Click radio button MEA32-STIM4. Restart MC_Stimulus II for the settings to take effect. 
 

 
 
In STG menu of the main menu toolbar, please click “Select Device”. 
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The “Select Device” dialog appears. Please select the USB-MEA32-STIM4 device you want to connect  
to by the serial number. Like MC_Rack, MC_Stimulus II can also be opened several times at once. Open 
one instance of MC_Stimulus II for each USB-MEA32-STIM4 device connected to the computer and 
assign each instance to one device. All available stimulation devices are listed by their serial numbers. 
 

 
 

5.2.2 Selection of Stimulation Electrodes 

Select the stimulation electrodes in main menu Edit "Channel Select". 
 

 
 
It is possible to assign stimulation channel 1 and 2 to stimulation electrodes S 1 to S6. It is not possible  
to select the same electrode for both channels. Stimulation electrodes S 7 to S 12 have to be assigned  
to channel 3 and 4. If you do not need four channels for stimulation, click check box "channel off".  
 

 

Warning: Please switch off all unused stimulation channels, even if no stimulation pulse  
is programmed.  
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5.2.3 Programming of Stimulation Pulses and Triggers 

For programming and downloading of stimulation pulses in MC_Stimulus II please see the respective 
manual. The USB-MEA32-STIM4 device has four internal trigger outputs, Sync Out 1 to 4, which can  
be assigned to the four stimulation channels. These four Sync Out channels will show up in MC_Rack  
on bits 0 to 3 of the digital channel, so it is possible in MC_Rack to trigger on the exact time point of 
stimulation from each of the four internal stimulation channels.Please use the Auto Sync Settings dialog 
from the Edit menu to assign one Sync Out to each stimulation channel. Check if the Auto Sync function 
is activated in the Settings menu. Pre and post time are only relevant for amplifiers with blanking 
function, both can be set to 0. 
 

 
 
To be able to start and stop all four stimulation channels individually, please assign the stimulation 
channels and the corresponding Sync Out to individual triggers in the Trigger Settings dialog in the  
Edit menu. 
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With these settings, a Sync Out will automatically be generated for each programmed stimulation pulse, 
and each of the four available triggers will start one stimulation channel and the corresponding Sync Out. 
Please see the MC_Stimulus II manual for detailed description of Auto Sync and Trigger Settings function.  
 

  
 
It is now possible to start and stop each channel and the corresponding Sync Out individually with the 
four start stop buttons for the four internal triggers. An orange control LED indicates an active stimulation 
channel. 
 

  
 
The regular Start / Stop buttons will start and stop all channels. Please remember downloading  
the stimulation pattern after each change with the Download or Download and Start buttons. 
 

  
 

5.2.4 Triggering on Sync Out in MC_Rack 

The Sync Out channels 1 to 4 show up in MC_Rack on the bits 0 to 3 of the digital channel.  
To trigger on those, use a Trigger Detector in MC_Rack set on the digital channel. To trigger on  
one Sync Out, select the appropriate bit, as shown below for Sync Out 1. To trigger on any Sync Out, 

unmask bits 0 to 3 and set the condition to > 0. Please see the screen shots below. 

Sync Out 1 bit 0 
Sync Out 2 bit 1 
Sync Out 3 bit 2 
Sync Out 4 bit 3 
 

             
Trigger only on Sync Out 1                                 Trigger on Sync Out 1, 2, 3 or 4 
 
For more details on triggering on the digital channel, please read the MC_Rack manual. 
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5.3 LTP-Director: Recording and Stimulation Software 

Start LTP-Director. In menu "Settings" click "Hardware" tab. 
 
Select "Hardware Configuration" USB-MEA32-Stim4  and "Device Serial Number" USB-MEA32-STIM4 
00015. The amplifiers gain is fixed to factor 1000. Select the "Sampling Frequency".  
 

 
 
In the main window of LTP-Director Test Mode you see the first layout of the pMEA32S12-L1. Select the 
stimulation electrodes (S1 to S12) in the white field of the blue control window that mirrors the pMEA 
layout, rotated by 90° degree.  
 
The LTP-Director can deliver two independent stimulation pathways to different electrodes. One electrode 
can be selected for each pathway. The electrode of stimulation pathway S1 is labeled with a small red 
square in the upper left corner of the electrode symbol in the electrode grid. The electrode belonging  
to stimulation pathway S 2 is labeled in black. Selected pulse parameters apply to both pathways. 
 
To select an electrode for stimulation pathway S 1, just click on the electrode you want to select, it will  
be marked in red. To select an electrode for S 2, hold the Shift key and click on the electrode, it will be 
marked in black. To deselect an electrode, click on the electrode symbol again or press Shift key and click 
again. LTP-Director does not allow to select more than one electrode for one pathway. Please read the 
LTP-Director manual or help for detailed information. 
 
The pulse interval (time between two pulses of one pathway) can be set between 0.5 and 180 seconds. 
This interval refers to one stimulation pathway. When using two stimulation pathways, pathway S 2 will 
be delivered in the middle of the pulse interval of pathway S1. So, the time delay between a stimulus on 
pathway S 1 and S 2 will be half of the selected pulse interval. Example: Selected a pulse interval of 1 min 
and two pathways. There will be one stimulus every 30 s alternately on pathway one and two. 
Please see LTP-Director manual for details. 



 

33 

6 Troubleshooting 

6.1 Troubleshooting 

The following hints are provided to solve special problems that have been reported by users. Most 
problems occur seldom and only under specific circumstances. Please check the mentioned possible 
causes carefully when you have any trouble with the product. In most cases, it is only a minor problem 
that can be easily avoided or solved. If the problem persists, please contact your local retailer. The highly 
qualified staff will be glad to help you. Please inform your local retailer as well, if other problems that are 
not mentioned in this documentation occur, even if you have solved the problem on your own. This helps 
other users, and it helps MCS to optimize the instrument and the documentation. Please pay attention  
to the safety and service information in the separate manuals of the related products and in the software 
help. Multi Channel Systems has put all effort into making the product fully stable and reliable, but like all 
high-performance products, it has to be handled with care. 
 
 

6.2 Overall Noise 

Problem: High frequency noise (50 Hz) 
 
Possible causes: 
 
? Perfusion is not properly grounded. Ground PH01 and aspiration needle to the ground plugs  
of the system.  
 
? If using a CVP, include a metal part in the tubing to the CVP and ground it. 
 
? Noisy equipment is too close by, for example the binocular lamp. Cover the pMEA with aluminum foil 
and connect the foil to the system ground. Remove or shut down unneeded equipment.  
 
Problem: Low frequency noise 
 
Possible causes: 
The USB-MEA32-STIM4 has a wide filter bandwidth (0.5 Hz to 3 kHz). Therefore, it is likely that you will 
pick up low frequency noise. Use a virtual 10 Hz High Pass filter, please see MC_Rack manual for details. 
 
 

6.3 No Computer Connection / No Recording Possible 

Problem: You cannot establish a connection to the computer. USB-MEA32-STIM4 is not available  
in MC_Rack. When loading a previously saved virtual rack file, you will get an error message and the 
simulation mode will be started automatically. Or you get an error message when starting the recording  
in MC_Rack after a successful computer connection. 
 
Possible causes: 
? The supply power is not connected or there is a technical problem with the device. 
 
Check the power source and the cable connections. If this does not solve the problem, contact your local 
retailer for support. 
 
? The USB port might not support USB 2.0 or might not be working. 
Check the USB port. Only high speed USB 2.0 ports can be used. Try another USB 2.0 port. 
 
? You can establish a connection, but get an error message when starting the recording in MC_Rack.  
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The bandwidth of the USB port is not sufficient for recording. This can be the case if the USB-MEA32-
STIM4 is connected via USB hub, and a second device that sends or receives continuous data streams,  
for example, a web cam or USB speakers, is connected to the same USB port. Connect the USB-MEA32-
STIM4 device directly to a USB port, not via hub. 
 
 

6.4 MEA is defective 

Perforated MEAs wear out after multiple uses. This is considered a normal behavior. pMEAs are also easily 
damaged by mishandling, for example, if wrong cleaning solutions or too severe cleaning methods are 
used or if the recording area is touched. If you observe a bad long-term performance of pMEAs, consider 
a more careful handling. Also do not apply too high/too long stimuli. This might lead to electrolysis and 
destruction of the electrodes. 
 
Problem: The noise level on individual electrodes is significantly higher than expected or you  
see artifact signals. In the following example electrode number 13 shows a high noise level. 
 

 
 
Possible causes: 
? The contact pads are contaminated. 
 
Clean the contact pads carefully with a swab or a soft tissue and pure (100 %) alcohol. 
 
? The contact pads or the electrodes are irreversibly damaged. You could have a look at the electrodes 
under a microscope: If they appear shiny golden, the TiN is gone and the electrode is irreversibly 
damaged. Electrodes may be damaged without changing their visual appearance, though. If too many 
electrodes are defective, use a new pMEA. 
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7 Appendix 

7.1 Technical Support 

Please read the chapter "Troubleshooting" of the user manual first. Most problems are caused  
by minor handling errors. Contact your local retailer immediately if the cause of trouble remains unclear. 
Please understand that information on your hardware and software configuration is necessary to analyze 
and finally solve the problem you encounter. Please keep information on the following at hand:  

1. Description of the error (the error message text or any other useful information) and of the 
context in which the error occurred. Try to remember all steps you had performed immediately 
before the error occurred. The more information on the actual situation you can provide, the 
easier it is to track the problem. 

2. The serial number of the device. You will find it on the backside of the housing or in MC_Rack 
“Hardware” tab. 

3. The operating system and service pack number of the connected computer. 

4. The hardware configuration (microprocessor, frequency, main memory, hard disk) of  
the connected computer. This information is especially important if you have modified the 
computer or installed new hard- or software recently. 

5. The version of the recording software. On the "Help menu", click "About" to display  
the software version. 

 

 

7.2 Contact Information 

Local retailer 

Please see the list of official MCS distributors on the MCS web site (sales info). 

User forum 

The Multi Channel Systems User Forum provides the opportunity for you to exchange your experience  
or thoughts with other users worldwide.  

Mailing list 

If you have subscribed to the mailing list you will be automatically informed about new software 
releases, upcoming events, and other news on the product line. You can subscribe to the list on the 
contact form of the MCS web site. 
 

www.multichannelsystems.com 
 

http://www.multichannelsystems.com/sales
http://multichannelsystems.forumieren.de/forum
http://www.multichannelsystems.com/about
http://www.multichannelsystems.com/
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7.3 Technical Specifications 

The USB-MEA32-STIM4 is a 32-channel amplifier with integrated Analog / Digital board converting  
analog signals to digital data streams in real-time. It is intended to directly contact to a 32 electrode  
Micro Electrode Array (MEA). 
 

 
General Characteristics 

 

Operating temperature 10 °C to 50 °C 

Storage temperature 0 °C to 70 °C 

Relative humidity 10 % to 85 %, non-condensing 

Dimensions (L x D x H) 235 x 135 x 55 mm (with PH01 on top) 

Weight   900 g 

 
Amplifier 

 

Number of recording electrodes 32 

Input voltage range +/- 4096 µV 

Data resolution 16 Bit 

Bandwidth 0.5 Hz to 3 kHz 

Gain       1000 

Cross talk (channel to channel)   typical 0.01 %, max. 0.1 % 

 
Data converter and USB interface 

 

Sampling frequency  up to 50 kHz 

Maximal data rate 6.4 MByte per second 

Data resolution 16 Bit 

USB Version  USB 2.0 High Speed 

 
Stimulus Generator 

 

Number of stimulation channels 4 

Output current +/- 256 µA 

Resolution 13 bit 

Maximum frequency 50 kHz 

Time resolution 20 µs 

 
PH01 perfusion cannula 

 

Temperature sensor type PT 100 with 4 wire connection 

Accuracy +/- 0.1 °C 

 Heating element impedance  20  

 
Power supply unit (MPU30) 

 

Input voltage 90 to 264 VAC @ 47 to 63 Hz 

Output voltage 11 - 13 V 

Max. Power   30 W    

 
Rear Panel interface and connectors 

 

USB USB 2.0 High Speed cable (type A - mini B) 

Ground   Common jack 4 mm, banana plug 

Power supply Barrel connector 0.7 x 2.35 mm 
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Software  

Microsoft Windows ® operating system Windows 7, Vista or XP with NTFS  
English and German versions are supported 

MC_Rack program Version 3.7.0 and higher 

Data acquisition and analysis software   

MC_DataTool program   Version 2.4.5 and higher  

Data export ASCII (*.txt),  binary file (*.raw) format  

MC_Stimulus II Version 3.0.0 and higher 

Stimulation software  

LTP-Director Version 1.0.0 and higher 

Data acquisition, analysis and stimulation 
software 

 

 

 

Warning: The USB-MEA32STIM4 device may only be used together with microelectrode array 
(pMEA32S12-Lx) from Multi Channel Systems MCS GmbH, and only for the specified purpose. 
Damage of the device and even fatal injuries can result from improper use. Do not open the 
data acquisition box and do not change hardware configuration as it could lead to improper 
behavior of the system. 
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7.4 Test Model Probe 



© 2018 Multi Channel Systems MCS GmbH
a division of Harvard Bioscience, Inc.

Product information is subject to change
without notice.

Phone    +49-7121-909 25- 0
Fax        +49-7121-909 25-11

sales@multichannelsystems.com
www.multichannelsystems.com

Multi Channel Systems
MCS GmbH
Aspenhaustrasse 21
72770 Reutlingen
Germany

Test Model Probe for USB-MEA32STIM4-Systems

Stimulation 
For stimulation are the recording electrodes organized in four blocks of eight recording electrodes,
each connected to three stimulation electrodes. Please see the circuit diagram of the fi rst block above.
The fi rst block of recording electrodes A 1 to A 8 can be stimulated via stimulation electrode S 1, S 2 
or S 3. The second block of recording electrodes A 9 to A 16 can be stimulated via stimulation electrode 
S 4, S 5 or S 6. The third block of recording electrodes A 17 to A 24 can be stimulated via stimulation 
electrode S 7, S 8 or S 9. The fourth block of recording electrodes A 25 to A 32 can be stimulated via 
stimulation electrode S 10, S 11 or S 12.
To test the stimulation electrodes, apply a MC_Stimulus II protocol via the internal stimulation generator 
to the stimulation electrodes. For more information, please see the USB-MEA32-STIM4-System manual.
Alternatively you can use an external STG. Connect the external stimulus generator to the plugs labeled 
with ground GND and electrode number 1 to 8 (fi rst block), 9 to 16 (second block), 17 to 24 (third block), 
and 25 to 32 (fourth block).

Test-32MEA

The provided test model probe is used for testing the 
noise level of the USB-MEA32-STIM4 amplifi er. All 32 
recording electrodes are automatically connected to 
ground for measuring the noise level of the electrodes. 
The test model probe simulates a pMEA32S12-Lx with 
a resistor of 220 k and a 1 nF capacitor between 
ground and each of the 32 recording electrodes. Scope of delivery:

1 Test Model Probe Test-32MEA

Warning: The device may only be used together 
with the USB-MEA32-STIM4-System from Multi 
Channel Systems MCS GmbH, and only for the 
specifi ed purpose. Damage of the device and 
even fatal injuries can result from improper use.

!
Ground  External Stimulation

Stimulation       Recording
 Electrodes        Electrodes

A 1

A 2

A 3

A 4

A 5

A 6

A 7

A 8

S 1

S 2

S 3

extern
al stim

u
latio

n

Example: 
Circuit diagram of recording 
electrodes A 1 to A 8, and 
stimulation electrodes S 1 to S 3.
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7.5 Data Sheet 

 
 



Technical Specifications         

    © 2018 Multi Channel Systems MCS GmbH 

 
 
perforated MEA (Microelectrode Array) for MEA2100-32- and USB-MEA32-STIM4-System                                                  
 
 

pMEA for use with 
MEA2100-32- and 
USB-MEA32-STIM4- 
System  
 
 
Temperature compatibility 
Dimension (W x D x H) 
Base material 
 
Perforation: 
Total area of perforation 
Diameter of the holes 
 
Contact pad 
Track material 
 
Electrode diameter 
 
 
Interelectrode distance 
 
Electrode height 
Electrode type 
 
Isolation type 
Electrode impedance 
 
Electrode layout grid 
 
Number of electrodes 
 
 
Ring 

 

pMEA-32S12 Layout 1 
 

 
 
 
 
 

10 °C – 50 °C 
49 x 25 mm x 180 µm 
Polyimide foil on ceramic 
carrier with perforation 
 
0.8 mm2 
20, 30, 50, 75 and 90 µm 
 
Titanium nitride (TiN) 
Titanium (Ti) 
 
30 µm (recording electrode) 
50 µm (stimulation electrode) 
 
90 and 150 µm (record.electrode) 
100 and 125 µm (stim. electrode) 
Planar 
Titanium nitride (TiN) 
 
Polyimide foil  

< 100 k 
 
1x10+1x12+1x10 (record. electr.) 
2x6 (stimulation electrodes) 
32 recording electrodes 
12 stimulation electrodes 
1 internal reference electrode 
Without ring 
Glass ring 

 

pMEA-32S12 Layout 2 
 

 
 

 
 

 
10 °C – 50 °C 
49 x 25 mm x 180 µm 
Polyimide foil on ceramic 
carrier with perforation 
 
0.8 mm2 
20, 30, 50, 75 and 90 µm 
 
Titanium nitride (TiN) 
Titanium (Ti) 
 
30 µm (recording electrode) 
50 µm (stimulation electrode) 
 
90 and 150 µm (record.electrode) 
90 and 150 µm (stim. electrode) 
Planar 
Titanium nitride (TiN) 
 
Polyimide foil 

< 100 k 
 
1x10+1x12+1x10 (record. electr.) 
2x6 (stimulation electrodes) 
32 recording electrodes 
12 stimulation electrodes 
1 internal reference electrode 
Without ring 
Glass ring 

 

pMEA-32S12 Layout 3 
 

 
 

 
 

 
10 °C – 50 °C 
49 x 25 mm x 180 µm 
Polyimide foil on ceramic 
carrier with perforation 
 
0.8 mm2 
20, 30, 50, 75 and 90 µm 
 
Titanium nitride (TiN) 
Titanium (Ti) 
 
30 µm (recording electrode) 
50 µm (stimulation electrode) 
 
90 and 150 µm (record.electrode) 
90 and 100 µm (stim. electrode) 
Planar 
Titanium nitride (TiN) 
 
Polyimide foil 

< 100 k 
 
1x10+1x12+1x10 (record. electr.) 
3x4 (stimulation electrodes) 
32 recording electrodes 
12 stimulation electrodes 
1 internal reference electrode 
Without ring 
Glass ring 

 
pMEA-32S12 Layout 4 

 
 
 
 

 
 

10 °C – 50 °C 
49 x 25 mm x 180 µm 
Polyimide foil on ceramic 
carrier with perforation 
 
0.8 mm2 
20, 30, 50, 75 and 90 µm 
 
Titanium nitride (TiN) 
Titanium (Ti) 
 
30 µm (recording electrode) 
50 µm (stimulation electrode) 
 
100 and 100 µm (record.electr.) 
100 and 100 µm (stim. electrode) 
Planar 
Titanium nitride (TiN) 
 
Polyimide foil 

< 100 k 
 
4x8 (recording electrode) 
2x6 (stimulation electrodes) 
32 recording electrodes 
12 stimulation electrodes 
1 internal reference electrode 
Without ring 
Glass ring 
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7.6 Scope of Delivery 

1 USB-MEA32-STIM4 device 

1 Temperature Controller TC01 

1 Data acquisition computer 

1 USB 2.0 High Speed cable (type A - mini B) 

1 Power supply unit with country specific power cord 

1 Data acquisition and analysis software MC_Rack (Version 3.6.7 and higher)    

1 Stimulation software MC_Stimulus II (Version 3.1.1 and higher) 

1 Data export software MC_DataTool (Version 2.4.3 and higher) 

1 OPTIONAL: Software LTP-Director and LTP-Analyzer Data acquisition, analysis and 
stimulation software  

1  USB-MEA32-STIM4-System Manual 

1 USB-MEA32-STIM4-System Data Sheet 

5 pMEA32S12-Lx, Layout as specified 

5 O-rings for sealing the suction port, Silicon 70, 7 x 1 mm 
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